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Welcome to the iRecord training manual. This manual guides you through learning how to use iRecord to record your
wildlife sightings and to share them with the rest of the wildlife recording community. We’ll also be exploring how
you can use iRecord to explore records added by other recorders - a great way to discover more about the wildlife
around you.
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CHAPTER

ONE

WHY IRECORD?

If you’re reading this page then I’m sure I don’t need to go into details as to why wildlife recording can be a fascinating
and rewarding activity. Hopefully after reading this you will realise that iRecord can not only make wildlife recording
even more enjoyable but can also make your recording efforts become much more worthwhile. Biological recording is
not just about having fun, as good quality biological records are essential to inform everything from planning decisions
to political policy to scientific research. At it’s most fundamental level wildlife records are collected on paper or in
digital form such as a spreadsheet. It’s all too easy for the records to get forgotten about and left exactly where they
are; the records are then not available for anything from planning decisions to research. Contrastingly, by using an
online recording system like iRecord you can easily:

• Share your sightings with the recording community

• Explore dynamic maps and graphs of your data

• Ensure that your records are available to appropriate organisations and therefore make a real contribution to
science and conservation.

Online wildlife recording presents a plethora of new opportunities :

• Sharing records is simplified to the point that the recorder need not actually do anything other than add their
records to the system. Records can be easily shared with other recorders, local record centres and the NBN
Gateway.

• By sharing our records, we can learn from the experiences of others such as what is being recorded on our patch
by others, what identifications are being verified by experts and so forth.

• By sharing our records, we can get rapid feedback from experts and other recorders on record quality issues.

• By sharing our records, we can ensure our records are of maximum value and not just known only to ourselves.

Tip: iRecord’s philosophy is that sharing of non-sensitive records is a fundamental part of wildlife recording. In fact,
unless there are sensitivity issues relating to a record iRecord makes records available for public interest and to support
nature conservation. iRecord is not the right tool for you if you want to keep a private list of records!
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CHAPTER

TWO

TUTORIAL - USING TRAINING MODE IN
IRECORD

Register on iRecord

Before starting any tutorials on using iRecord, make sure that you’ve registered a user account and can log in.
You can do this via the links from the iRecord home page.

Whilst learning iRecord, you will want to go through the steps of actually submitting records into the system and
seeing the results. If you are concerned about putting records into iRecord whilst you are still learning the ropes then
don’t worry as iRecord supports a training mode. Whilst in training mode:

• the records you add are flagged as training records so they won’t be sent on to experts, local environmental
record centres or the NBN Gateway.

• training records are hidden from view for all users of iRecord unless they are also in training mode.

• filter the reports you see so that you can see the training records.

Tip: You can watch a video of how to set iRecord into training mode.

To enable training mode, follow these steps:

1. Select My Account from the link in the top right of the screen.

2. Click on the Edit tab, under the My Account title.

3. Click on the Preferences tab.

4. Tick the Training checkbox.

5. Scroll to the bottom and click the Save button.

The following screenshot shows the My Account link, Edit tab, Preferences tab and Training checkbox:
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Once you are in training mode, you will find that a message is displayed at the top of each page warning you. You
can see from the following screenshot that the records visible on the home page are those which I’ve previously input
whilst in training mode.

Don’t forget to unset the training option when you want to start inputting live records! When you do this, your training
records will remain in the system but will be hidden from your view until you choose to return to training mode.

6 Chapter 2. Tutorial - Using Training Mode in iRecord



CHAPTER

THREE

TUTORIAL - ENTERING A SIMPLE
RECORD

Tip: You can watch a video of how to input a minimalistic record.

A wildlife recording system is nothing without the records it contains, so what better way to start learning iRecord
than to input a simple record. The exact information you might want to record will depend on what you are recording
and why you are recording it, but most agree that all biological records need to include the following information:

• Who recorded it

• Where it was recorded

• When it was recorded

• What was recorded

We will normally be logged in to iRecord when we input records, so the system already knows who you are and can
use this information to provide the default value for “who recorded it”. iRecord includes a limited number of ways of
inputting records even when you are not logged into the system but in these cases you would be asked to fill in basic
details of yourself. As iRecord is far more useful when logged in, we’ll be focusing on inputting data as a logged in
user. The other key parts of a record, the “where, when and what” will need to be input when you add a record to the
system.

Tip: When practicing using iRecord to input records, if you want to input data that are not real make sure you turn
on the training option in your user profile. More information on using the training option or watch how to do this this
on YouTube.

To add a record:

1. First make sure you are logged in.

2. Select Record > Enter a casual record from the main menu. This takes you to the form which you will fill
in for general ad-hoc records. There are other forms for lists of records as well as forms catering for specific
surveys, species groups and places which we will learn about later. The top half of this form allows you to set
most details of the record other than the locality information, which we will come to in a moment.

7
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3. For this tutorial. we’re going to input the very minimal details required for a record. Click in the box beside the
Date label and you will see that a calendar panel pops down making it really easy to simply click on the correct
date. If you need previous months or years then you can use the controls at the top of the panel to change the
visible month. Obviously future dates are not allowed.

So, click on today’s date to set the date for the record.

4. The Recorder Name field has already been filled in with our name as a default value, so the next piece of
information we must provide for our minimalistic record is the species name. Click in the box next to the
Species label. Start typing the first few characters of a species name, e.g. “blueb” to search for Bluebell,
Hyacinthoides non-scripta. The list of possible matched species names appears below the input box:

8 Chapter 3. Tutorial - Entering a simple record
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If the species you are looking for has come to the top of the box then simply press return to select it, or you can
use the arrow keys to navigate in the list then press return when the species you want is highlighted.

5. The final piece of information we need to provide for our record is some information on the place, such as a
grid reference. There are several ways to do this, but the quickest is to scroll down the page till you can see the
map, then move the mouse over the map to the general area of the record. As you hover over the map, you can
see a dotted outline of the grid square which you are currently over informing you where the grid square will
be set when you click. Don’t worry about making it too precise at this stage - simply click on the map in the
approximate location of the record. The map will now zoom in so that you can click again to set a more precise
grid reference. Repeat this until your grid reference is placed to an appropriate level of precision. A 10m grid
square is a good aim.

9
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Note: We’ll learn about repeat recording at sites as well as how to increase the grid reference precision to 1m
later.

6. Finally, click the Submit button to save your record.

10 Chapter 3. Tutorial - Entering a simple record



CHAPTER

FOUR

WHERE DOES THE RECORD GO?

One of the big benefits of iRecord over using pencil and paper and even some other computerised recording systems is
in relation to where your records go after you submit them. Many recorders are motivated to record wildlife because
they want to ensure that records are available to decision makers, planning authorities, scientists, recording schemes
and societies. Records on paper need considerable effort to get them into a form where they can be utilised. Even
records in spreadsheets take considerable effort to import them into the databases used to collate records, since species
names and other terms all need to be matched with the correct equivalents in the database. This might sound trivial
but don’t forget that many species names are not unique; a redshank is a plant or a bird for example. A combination
of the effort required to process records and the lack of awareness of the importance of collating records means that
many records remain exactly where they started out - on paper or on a spreadsheet. This is even true of many records
collected from that most modern of recording phenomena, the bioblitz; the effort required to mobilise the data is
often considered not worth it. Of course that’s not to say that we shouldn’t hold events purely with the aim of public
engagement, but with iRecord we hope to make mobilising records much easier so there are no good reasons not to.

11
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iRecord helps you to match species names correctly at the point of data entry by showing you the common name, latin
name and species group when you pick a name, so issues with matching names are no longer a factor. The record is
immediately in digital form with correctly input grid references picked from a map, no ambiguity in the way dates
are written and so forth. Therefore fully utilising the records which are input into iRecord becomes much simpler.
Creating an accurate record right from the outset is only part of the story, so lets take a look at what else happens next
behind the scenes.

4.1 The Database

All records added to iRecord go straight into a database hosted by the Biological Records Centre known as the com-
munity warehouse. This name reflects the fact that the database is shared with a community of other online recording
websites for reasons which we will come to later. The records are held securely and are regularly backed up.

4.2 Records are immediately available

All non-sensitive records added to iRecord are immediately available for browsing on the Explore pages of the website.
Local environmental records centres have instant access to records, to ensure that they are not overlooked in the local
planning process while they are waiting for verification. Of course, a record needs to be verified before it is used
as evidence for decision making, but instant access to unverified records can help ensure that important species and
habitats are not harmed due to lack of awareness of their presence.

12 Chapter 4. Where does the record go?
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4.3 Automated checks

Records added to the database are subjected to a number of automated checks. For example, if a record is outside the
expected distribution of the species or at an unexpected time of year, then a flag is added to the record marking it as
such. These flags shouldn’t be considered as an indication of a “bad” record though - a record which is outside the
known distribution is exactly the sort of record which can show the movement of a population if enough evidence is
available to verify the record.

If you are interested in finding out more about how the rules are decided upon, then you need to know that the rules
used for the automated checks are imported into iRecord’s processing systems from the NBN Record Cleaner, an
application designed to help experts quickly verify records. The parameters used for the rules themselves are authored
by the relevant recording schemes.

4.4 Expert Verification

The next, critical step in the journey of the record is a review by an expert. Only expert verified records can be used
as evidence in planning enquiries, species atlases etc. That doesn’t mean a record that cannot be verified is not useful;
even if it only gives guidance for further professional surveying every record is valuable.

Experts have access to a list of the records pending verification, which is filtered to their region and taxonomic special-
ity as appropriate. They also have tools to quickly verify records (e.g. verify en masse all records of common, easily
identified bird species by trusted recorders). Photos uploaded with records can be a great help in verifying records of
some species groups but in many cases the expert needs to contact the recorder to check further details or to ask if a
specimen is available. iRecord’s verification system includes tools to make all these tasks as simple as possible for the
expert so that they can concentrate on the important task of checking through the records.

The above screenshot shows the verification system in iRecord. Notice how the verifier is able to verify records from
multiple places from a single screen - in this case, iRecord, Norfolk Biodiversity Information Service and the Bees,
Wasps and Ants Recording Scheme.

Earlier we mentioned that the community warehouse database hosts records from several different wildlife recording
websites. This means that experts can verify records from all the systems in one place - not only do they not have to
log in multiple times, but they don’t have to learn multiple systems. There are of course other online recording tools
around with their own verification systems but with iRecord we are at least attempting to avoid making things harder
than they need to be.

4.3. Automated checks 13
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4.5 Records are passed to the NBN Gateway

The NBN Gateway is the UK’s portal for exploring biodiversity data, a node of the Global Biodiversity Information
Framework (GBIF). All verified records from iRecord are shared via the NBN Gateway in datasets administered by
the relevant recording scheme, local records centre or survey organiser. From there, the records are made available to
a number of other websites via NBN web services, and to an international audience via GBIF.

The NBN Gateway makes iRecord records available for public interest and to support nature conservation. The records
may be used for research and commercial purposes with written permission from the dataset administrator.

14 Chapter 4. Where does the record go?



CHAPTER

FIVE

TUTORIAL - MY ACCOUNT

iRecord allows you to customise several aspects including the species groups you like to record most often and the
region you most often record in. These are then used to customise reports and can also be used to simplify data entry
or to bring to your attention any recording forms which might be of interest, so it’s worth spending a few moments
familiarising yourself with the possibilities.

To access your account, click on the My Account link in the top right of any page.

The My Account section is divided into 3 tabs as follows:

5.1 The My Data Summary Tab

This tab shows a very simple summary of the records that you have added to iRecord so far:

5.2 The View Tab

The View tab shows a summary of your settings, for example:

15
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Note on this tab the section called Recording Preferences which tells you whereabouts like to record and what I’m
mostly interested in. We’ll find out more about this later. In this screenshot, for illustration purposes it shows that I
am a verifier for records of butterflies in Dorset (I’m not, but that wouldn’t be a very good illustration without a bit of
tweaking!)

5.3 The Edit Tab

The Edit Tab is divided into 3 further sub-tabs. The one we are interested in is called Preferences:

16 Chapter 5. Tutorial - My Account
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On this page, please set:

• Location to the locality you most often like to record in.

• Species groups to the species groups you are most interested in.

Note that the list of locations available to pick from uses the list of Watsonian Vice Counties. These are often used
in biological recording since they are persistent and not subject to the changes that our list of administrative areas are
subject to.

Also note that the list of species groups available correspond to the species group reporting categories used by the UK
Species Index. We are in the process of reviewing these to make the options simpler.

When you have set the options remember to click the Save button at the bottom of the page.

5.3. The Edit Tab 17
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CHAPTER

SIX

GENERAL PURPOSE DATA ENTRY
FORMS

When using iRecord, there are 3 general purpose data entry forms which will always be available to you. Since these
let you record any species group, each record only has some basic attributes which are relevant to most groups. We’ve
already briefly used the Enter a casual record form when we entered a minimalistic record earlier. In this section we’ll
take a look at this form in more detail as well as additional forms used when inputting multiple records:

6.1 Tutorial - Enter a casual record

Since we’ve already used the Enter a casual record form when we added a simple record earlier, we’ll take this
opportunity to take a look in more detail at the standard attributes we capture for each record in iRecord.

6.1.1 Date

Put simply, when the record was recorded. This field does not allow future dates to be input.

6.1.2 Recorder Name

This will default to your own name. When entering data on behalf of someone else, or a group of people, use this field
to specify who.

6.1.3 Species

The species name, as looked up from the UK Species Index. This supports data input using latin names and common
names. Note that internally, whether you use the latin name, common name or even a synonym for data input, iRecord
understands the species concept you are referring to. So you can’t cheat - a record of Wren plus a record of Troglodytes
troglodytes does not make 2 species on your bioblitz checklist!

When you pick a species name, iRecord shows you the species group you are picking from in the drop down list
of options. This helps prevent mistakes where common names are used to mean different things in different species
groups, such as magpie (moth, fungus or bird?), redshank (flowering plant, moss or bird?).

19
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6.1.4 Certainty

Although most records are put on iRecord with a relatively high degree of confidence in the identifications, there are
many reasons why iRecord should accept less than certain records.

• Uncertain records can still act as a pointer to others who may want to confirm the record themselves.

• An uncertain record as determined by the recorder might be accompanied by enough information for the record
to be verified by an expert.

• Most recorder’s like to keep all their records for the sake of completeness, not to have to discard the ones that
they cannot be 100% certain of. This is especially important to the newcomer recorder who might one day be
the expert verifying my records.

Therefore, always set the certainty of your record’s identification as it ensures that the record is not misinterpreted or
misused.

6.1.5 Quantity

As this is a general purpose record form, the Quantity field is a free text input box. You can give a count here if
appropriate, or some other indication of abundance.

6.1.6 Sex

Again, this is a general purpose form and this field may not be appropriate to all records, but where possible set the
sex of the organism if you can.

6.1.7 Stage

Again, this is a general purpose form and this field may not be appropriate to all records, but where possible set
the stage of the organism if you can. Note that iRecord does support more specialist recording forms, e.g. the UK
Ladybird Survey’s recording form, where the list of options for the stage is more specific.

20 Chapter 6. General Purpose Data Entry Forms
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6.1.8 Identified By

Knowledge of who identified a record is a really important piece of information when verifying the records. Therefore,
if the record was identified by someone other than yourself, please ensure you specify their name in the Identified By
box.

6.1.9 Location

The site name you recorded at, or other brief description of the location.

If you enter a site name and pick a grid reference for a site that you are likely to record at again in the future, then click
the Remember Site button which appears. This will add the site to your Tutorial - My Sites page where you can edit
the site boundary and explore the records from that site.

6.1. Tutorial - Enter a casual record 21
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6.1.10 Spatial Reference

Provide a British National Grid Reference. You can also input a latitude and longitude value, e.g. from a GPS.

The Tutorial - Data Entry Tips section gives lots of information on how this value can be set easily, which we’ll cover
later.

6.1.11 Habitat

If you are able to provide information on the habitat the record was found in, then it can be a very useful part of the
record. The habitat input is a hierarchical list - you first pick the broadest category of habitat, then the next level. If
you are only confident in picking the first level, then it is better to do that than to set an incorrect second level.

For those that are interested, the habitats available for selection on the iRecord general purpose forms are based on the
EUNIS habitat types classification, a standard widely used across Europe.

Tip: If you use one of the sites on your My Sites list, then the last input habitat for that site will be automatically
selected for you.

6.1.12 Comment

Use this box to provide any additional information you think might be relevant to the record.

6.1.13 Exercise

To make sure you’ve got to grips with all this, ensure you are in training mode and then enter the following records:

1. A record of a queen Bombus terrestris (buff tailed bumblebee), seen looking for nesting sites on 4th April 2013.
The grid reference was ST99550006. As you are not a bumblebee expert, you are trusting that Mr Smith (a
passing walker) was correct in the identification, so you can’t be certain.

22 Chapter 6. General Purpose Data Entry Forms

http://eunis.eea.europa.eu/habitats.jsp


iRecord Training Manual, Release 1.0

2. A record given to you by Mrs Sally Green of a hobby, from 20th August 2012. Site name was Badbury Rings,
grid reference ST966029. She is a known bird recorder so this is pretty certain. The habitat was a dry grassland.

6.2 Tutorial - Enter a list of records

This form is designed for quickly entering a list of records that were collected at the same place, on the same date, by
the same person. Each record added on the Enter a List of Records data entry form has exactly the same information
as the Enter a Casual Record form. The big difference is that you only input information about the visit once and you
use a grid to enter a list of all the records that share the same visit information. Another difference is that the form is
divided onto 2 tabs, with information about the place you visited on the second Where Was It? tab.

Entering the date, recorder name and visited place information is exactly like entering these details on the Enter a
Casual Record form. So, we’ll take a quick look at the different part which is the species input grid:

Inputting records is simply a matter of typing species names into the first, Species column. This matches the text you
input against the list of known species names, exactly as when you are inputting a single record. Once you have input
a species name, a new row is added to the bottom of the grid letting you continue adding more species records. When
you add a row to the grid for a species record, you can also set the following attributes of the record:

• Certainty

• Quantity

• Sex

• Stage

• Identified By

• Comment

• Images

6.2.1 Exercise

To ensure that you have got to grips with this form, try inputting the following records using training mode.

The records are of wood anenome, bluebell, common dog’s mercury and ramsons. All the records are certain. The
date was 15th April 2013, grid reference TQ566077, site name Abbot’s Wood.

6.2. Tutorial - Enter a list of records 23
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6.3 Tutorial - Enter records at several places

Although entering a list of records from one place on one day can be a quick way of inputting lists of records, most
recording trips involve records from more than one grid square. The Enter Records at Several Places form is designed
to handle this quickly and efficiently - you can add a number of grid squares to a map and enter any number of records
you like at each grid square.

Tip: You can watch a video of using the Enter Records at Several Places data entry form.

During this tutorial, you will enter records from several grid squares. We’ll guide you through entering some fictitious
records but at the end of the tutorial feel free to input some of your own records if there is time.

Make sure that you are logged into iRecord and use training mode to ensure that your records do not become live. Get
started by selecting Record > Enter records at several places from the menu. Parts of the form should look quite
familiar by now, but as we will see there are a few big differences on this form to the way other forms work which
allow us to easily add records for multiple grid squares. Select 12th April 2012 as the Date and leave the Recorder
Name field with its default value. In the Location box, type “Blandford forest”. We need to find the right place on the
map, so select Google satellite using the layer picker on the map (the blue cross button near the top right of the map).
Our records are a little west of a village called Durweston in Dorset, so type “Durweston” into the Search for Place
on Map box and press Search. Your form should look like the following, showing the centre of Durweston village:

24 Chapter 6. General Purpose Data Entry Forms
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Use the zoom bar on the left of the map to zoom out about 5 clicks, then drag the map so that the village is towards the
right. You should see Blandford forest as in the map below. I’ve marked the visitor centre at the entrance to Blandford
forest with a red cross as this is the approximate location of our first set of records.

Use the pan and zoom controls on the map to zoom in so that the forest more or less fills the map. We could of course
zoom right in if we wanted to provide greater precision. Click on the grid square which has the clearing containing the
visitor centre in the bottom left. This will set up our first grid square ready to input records; the map will slide out of
view to be replaced by a grid allowing input of the records at this grid reference.

Tip: If you record regularly at a site, don’t forget to use the Tutorial - My Sites feature to make finding repeat sites
really easy!

First, set the Habitat to “Woodland”, then choose “Broadleaved deciduous woodland” from the subcategory box
which appears.

Enter the following records:

• Holly

• Beech

• Pedunculate Oak

• Hazel

• Ramsons

• Bluebell (Hyacinthoides non-scripta)

Our grid should look something like the following:
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We can of course specify additional details for any of these records if required. Click the Finish button to the top right
of the grid when you are ready to continue to add the next grid square.

Next, we’ll add some records from just down the track. Click on the next grid square to the left (where the track forks)
to set the position for the next batch of records. This time set the habitat to “Woodland” > “Mixed deciduous and
coniferous woodland” and enter the following list:

• Scots pine

• Pedunculate Oak

• Hazel

• Gorse

• Wild strawberry

• Bramble

Click the Finish button when you are done. The map now shows both the grid squares you’ve added records for with
a brief summary; having zoomed in a bit my map looks like the following:
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We can of course continue to add lots more records at further grid squares, but since the aim of the game here is to
learn how to use the form’s features rather than to put records in, lets take a look at some of the other things you can
do. First, we can add an extra record to one of the existing grid squares. Click the Modify Records button above the
map. Note how the instructions just beneath the buttons changes to tell you what to do:

Please select the records on the map you wish to change.

So, simply click on the first grid square at the visitor centre. This returns us to the grid view of the records where
you are free to add new records, details of records or to remove records you no longer want to add. Try adding wood
anenome to the list and click Finish when you are done.

Next, let’s try increasing the precision of this grid square. The records were actually recorded at the north east of the
car park clearing by the visitor centre. Click on the Move Records button so the instructions now say:

Please select the records on the map you wish to move.

So, click on the grid square over the visitor centre. The instructions change to:

Please click on the map to choose the new position. Press the Cancel button to choose another set of records to
move instead.

Zoom the map in until you can set a 10m grid square (the “ghost” image under the mouse cursor shows you how
precise the grid square will be when you click). Click on the map just to the top right of the clearing. You should see
something like:
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Since this is a tutorial, try using the Delete records button to remove one of your grid squares.

Now that you are armed with the skills required to use this form, practice entering a few more records to make sure
that it is all clear. You can also try saving records (in training mode of course) then using the Explore > My Records
view to edit the records again and correct the positions of grid squares or other details of the records.
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CHAPTER

SEVEN

TUTORIAL - DATA ENTRY TIPS

Data entry in iRecord is designed to be as quick and intuitive as possible. However, in this tutorial we’ll take a look at
a few tips and tricks which can make things even easier. As usual, make sure you are in training mode before inputting
tutorial records.

First, select Record > Enter a list of records from the menu to access the standard form for entering record lists.

7.1 Control locking

We are going to input records given to us by a friend, from 2 different places, but on the same day. Click on the Date
control and set a date for your records to 14/04/2013. Now, click the padlock icon to the right of the date box. This
locks the control’s value so that it cannot be edited.

You can see that the date control is now greyed out and the padlock locked, indicating that the control value cannot be
changed. Try clicking on the date control and you will see that it no longer accepts input. The real value of control
locking is the control’s value will be remembered the next time you use this form. So, we can use this facility when we
need to input several batches of records which share some of the same attributes such as the date, place or recorder.

Type “Fred Blogs” into the Recorder Name and lock this control as well, since we are entering more than one batch
of records on Fred’s behalf.

7.2 Inputing lists of species

Next, click in the input box at the top of the Species column in the grid below.

Tip: Don’t forget that you can use the tab key to navigate forwards in the form - this is a standard feature of web
browsers. Shift tab allows you to navigate backwards.

Fred has given us a list of birds plus a list of plants for the first place & date he surveyed. This is the list as he wrote it:

• Lords and ladies

• Dog violet

• Greater-Spotted Woodpecker

• Parus caeruleus
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• Magpie

Let’s start inputting the names. We’re going to explore a few of the different issues relating to finding species names -
with a clear understanding of how it works you’ll be able to find names quickly and efficiently. So we’ll be deliberately
looking at some problematic data in order to learn how to handle it. Type “lords and” into the species name box. Your
search is sent to the server and used to lookup possible species name matches as follows:

This is an interesting (i.e. deliberately chosen) example. 3 results are shown, but they are all for Arum maculatum, i.e.
Lords-and-ladies or cuckoo pint. The reason is that iRecord uses the UK Species Index to provide species names and
the UKSI lists 3 variants of the common name Lords-and-ladies with different capitalisation. Another interesting point
here is that there are hyphens in the common names listed and the names were found even though we didn’t include
the hyphen in the characters we typed.

Tip: iRecord doesn’t care about punctuation and other special characters when you search for a species name, so
don’t bother typing them. In fact, spaces are also ignored - typing “7sp” is enough to find “7-spot ladybird” and would
also find 7 spot ladybird if it were listed without the hyphen.

Rather than pick a name, we’ll explore inputting this species name a little further so select the text you have input so
far and delete it. Now, type “armac” which is 2 letters from the genus name and 3 letters from the species name. This
should find the species for us as iRecord supports 2+3 letter abbreviations as used in some other recording systems.
However, as there are quite a few species with the same abbreviation, Arum maculatum does not make it to the top.
One way around this is to limit the search to flowering plants, which is particularly useful if entering a list of many
flowering plant records.

Tip: When using 2 + 3 letter species name abbreviations, utilise the filter button in the Species column header to
limit your search to the appropriate species group(s). This works even more effectivel when entering species from a
not-so-extensive group as flowering plants.

To change the species names filter, click the filter button in the column header of the Species column. This pops up
a dialog box allowing you to configure what names are available in the search filter. Select the option Input species
from the following species group then in the associated drop down box choose flowering plant.
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Click Apply. Now, clear the species name input box and type “armac” again. This time you will find that Arum
maculatum appears in the list a couple of places from the top. Use the down arrow key to move the highlighted name
down, then hit the return key to select it.

The species name is selected and a new row is automatically added to the grid. Note that the input cursor is put straight
into the new box in the Species column ready for you to continue typing species names. Let’s try the next name in the
list, written as “Dog violet”. Type this name in. Nothing is found - you can tell this because the rotating “searching
icon” appears briefly and then disappears, indicating nothing was found. One thing to bear in mind about using the
UK Species Index to lookup species names is it does not understand the vagaries of the ways that we often share
names. There are actually many dog violet species; we happen to know that Fred meant common dog violet, because
we know Fred would have specified if it were something different. But iRecord can’t make these assumptions for you.
If you can’t find a species name because you know that there is a part of the name missing, then insert a * character as
appropriate to act as a wildcard. Insert a * at the start of the species name input so you are searching for * dog violet
and you will find that a number of dog violet species are returned with common a little way down the list. Select it
and we’ll move on.

Now that we’ve input the plants from the list, click the filter button again and this time set the filter to “Birds” and
click Apply.

Since we know that iRecord does not care about capitalisation, spaces, or punctuation, type “greaterspottedwood” into
the next Species search box. Again, the name is not found (I did say we’d be deliberately looking for problems to learn
how to handle them!). You might have noticed that we are searching for “Greater” instead of “Great”, but assuming
that we hadn’t spotted this problem in the name we’ve input, a good way forward would be to search for something
like “great*woodpecker”, since we know that at least these parts of the name are unambiguous.

Tip: The * character is your friend when struggling to find a species name.

Fred has given us a latin name for the next species to input, Parus caeruleus. Input this name and, you’ve guessed by
now, the name will not be found. This is because P. caeruleus is the name used for blue tit until a few years ago, when
taxonomists realised it was not actually in the same genus as Parus major, the great tit. So, now it is known by the
new name Cyanistes caeruleus, though the previously used synonym is sometimes still in use. We don’t want to look
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up the correct name to use every time this happens, so another option is to enable searching for synonyms. To do this,
click the filter button in the Species column header again. This time, change the drop down option for Choose species
names available for selection to All names including common names and synonyms. In other words, all the names
available in the UK Species Index become available for searching, whether they are current or not. Now retype “Parus
caeruleus” and you should find that this time, the name is found.

As one more illustration of grid based name input, let’s try inputting a few dragonfly and damselfy names to examine
the most efficient key strokes. The list we will input is:

• Beautiful agrion - Calopteryx virgo

• Common Darter - Sympetrum striolatum

• White-Legged Damselfly - Platycnemis pennipes

Clear the species names you have input so far, and try the following key strokes as quickly as you can:

cavir<return>systr<return>plpen<return>

If you are a quick typist, you will notice that iRecord lets you start typing the species name for the next row before
it has looked up the first row’s name. You don’t have to wait for the species name to be matched, just get on with
typing names as fast as you like. This works for common names and latin names as well as abbreviations, though you
are obviously more restricted in the speed you can reach. For the last abbreviation, “plpen”, iRecord could not find a
unique species name match so the drop down list of possible matches is shown. At this point you have to break your
flow to click on the correct name.

Now, try the same experiment again, but type the following set of characters. Note the missing p in “plpen” which is
our pretend typo.

cavir<return>systr<return>plen<return>

This time, if you managed to press return before the search completed for the misspelt “plen”, then you will notice
with a “polite shake of the head” the species name input box informs you that it failed to find any matches. Time to go
back and correct it!

Tip: Practice using the keyboard only to input species and associated attributes into the input grid. In time it will
become intuitive and is faster than using the mouse.

One more thing, try typing “cavir” into the species search box then pressing <tab> instead of <return>. This time,
the species name is picked but the input focus moves to the next control in the same row. You can then use the up or
down arrow and return key to change the certainty of the record, or press tab again to change one of the other column
values. Press tab a few times to move to the next row when ready to add a new species name, or shift tab to move
backwards. When you are in a text input box (such as Quantity, Identified By or Comment you can use the up and
down arrows to navigate between rows, though the web browser reserves these keystrokes for selecting items when
the focused control is a drop down.

Tip: Don’t forget to use the record certainty attribute to mark up records which you are not certain of the identification
for. Also, note that if you are not certain of an identification to species level, but are certain of the genus you can always
add a record at genus level.

7.3 Uploading photos

The ability to attach up to 4 photos to each record added via the grid is accessed via the add images link in the
rightmost column of the grid. It’s simply a matter of picking an image file from your disk to upload.
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The file upload system used by iRecord examines the capabilities of your web browser to determine the best way
to upload files. For example, if you are using a modern web browser with support for the latest standards, then it
can resize the image so that the upload time is fast and show a progress bar for the upload. If you are running an
old browser which does not support the latest web standards, then it will do a standard file upload which will be
slow. If you are uploading multiple images for a batch of records, then a slow upload speed could become completely
unworkable quite quickly. The file upload system will also make use of installed browser plugins, as either Silverlight
or Flash can make a smoother upload process. The morale of the story is, if you have any difficulties using the photo
upload facility, then I recommend ensuring you are using the latest available version of your web browser and have
the latest versions installed of your Silverlight or Flash plugins.

7.4 Map tips

Tip: You can watch a video of map tips and tricks.

Here are a collection of tips and tricks for using iRecord’s map during data input. Try each tip out using the Record >
Enter a list of records page.

7.4.1 Map Layers

In case you haven’t already spotted it, try clicking on the blue + button in the top right of the map. This expands a
panel allowing you to choose from the various layers available. On the following screenshot, the first 2 are background
layers provided by Google - you can show only one of these at a time. The second 2 are overlays which are drawn
over the top of the base layer. You can show any combination of these you like.
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Try changing the settings to see what they do. When you’ve finished, click the - button in the panel to close it.

7.4.2 Navigating around the map

Also overlaid onto iRecord maps you will find navigation and zoom buttons on the left hand side. Although sometimes
handy, I prefer to use the mouse left button to drag the map around as required and to double click on the map to zoom
in. Make sure you experiment with these different techniques of moving the map around and zooming in before
continuing.

Another way to zoom into a precise region is to hold the shift key, then mouse-drag a rectangle on the map. The map
will then zoom to show the rectangle. Again, practice trying this yourself before moving on.

Tip: If you have a mouse wheel, or similarly featured gestures on a touchpad, then you can use this to zoom the map
in and out.
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A third way to zoom the map into a place is to use the search for a place on the map input box on the left to find a
town or village by name. Try typing “alfriston” into the box then click Search and the map will zoom into the village
of Alfriston in Sussex, as it managed to find a unique place with that name. If you try searching for a more ambiguous
name such as “arlington” you will see that you are given a list of possible matching places to pick from:

7.4.3 Setting a grid reference for your record

The simplest way to set a grid reference for your record is to click once on the map where you would like the record
to be. Most of the time this is all there is you need to know. The following points give you some extra details though:

1. As you hover over the map, a “ghost” image of the grid square you are about to pick is shown. This gives you a
preview of the square size and position.

2. The more you zoom the map in, the more precise the grid reference will be. The map won’t set a grid reference
that is more accurate than could realistically be expected from the scale of the map.

3. When you click to set a grid reference, the map will zoom into the grid reference square giving you a chance to
click again to set an even more precise grid reference.

4. If the map is showing the street map base layer, then when you click on the map to set a grid reference and it
automatically zooms in, if the zoom scale is high enough the map will automatically switch to satellite view so
you can set a precise grid reference more easily.

5. If you hold down the + key whilst over the map, the precision of the grid reference is increased

7.4.4 An exercise

To check you’ve got to grips with the map, see if you can:

1. use the map to set a grid reference for a 1m square on the top of the lighthouse just off Beachy Head, just to the
west of Eastbourne.

2. Input the following coordinate from a GPS: 51.53865N 0.01659W

3. Input the following tetrad (2km) grid reference: TR01Y. Use the streets background layer to find out where this
is.
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CHAPTER

EIGHT

EXPLORING THE RECORDS

One of the key features of iRecord is that non-sensitive records are immediately visible to other users. This allows you
to see what is being recorded near your patch or by your friends and colleagues. In this section we will take a look at
the Explore options available in iRecord for browsing existing records.

Tip: Whilst exploring records, don’t forget that the records you see will be those recorded in training mode if you are
in training mode yourself. Training modes will be excluded from the reports if you are not in training mode!

8.1 Exploring Records

There are 2 Explore pages accessible from the menus in iRecord - Explore all records and Explore my records. Both
are the same except that the my records version is filtered to only your own records.

The Explore pages are divided into 2 parts, a map panel and a data panel as described below.

8.1.1 Map Panel

The map shows records that match the current filter; in this case the filter is all records input by me. When you are
zoomed to show a distant view of the map, a small grid square would simply not be visible so iRecord automatically
draws a larger circle over the record until you are zoomed in far enough to show the record as a proper square. This
map image shows the appearance of records when you are zoomed out:
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And here are the same records, shown when zoomed in:

So, what do the various colours mean? The line drawn around the grid square and the circle drawn when zoomed
out both indicate the certainty of the record. For an unverified record, this is the certainty of the record according to
the recorder, but once a record is checked by an expert then that expert’s opinion overrides the opinion of the original
recorder. So, we see the following colours:

• Blue = unknown certainty & not yet checked by an expert

• Red = low certainty, or record has been rejected by an expert

• Orange = medium certainty, or record has been marked for querying by an expert

• Green = high certainty, or record has been verified by an expert.

The fill colour of the grid square always shows the expert’s opinion:

• Blue = not yet checked
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• Red = record rejected

• Orange = record marked for querying

• Green = record has been verified.

8.1.2 Data Panel

Underneath the map there is a data panel which shows a list of records currently loaded on the map:

In this grid, details of the record including any photos are shown. The icon in the species name column gives an
indication of the record’s quality:

• One star - record not yet checked by an expert and marked as uncertain by the recorder.

• Two stars - record not yet checked by an expert and marked as likely by the recorder.

• Three stars - record not yet checked by an expert and marked as certain by the recorder.

• Red cross - record checked by an expert and rejected. Note that you will only see rejected records on the Explore
My Records page, not when viewing records from other users.

• Amber question mark - record checked by an expert and marked for querying.

• Green tick - record checked by an expert and confirmed.

The data panel also shows a list of the species currently loaded on the map on the second tab:
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8.2 Explore > My photo gallery

For those of you who like to collect a gallery of your own images, the Explore > My photo gallery menu item
provides exactly that:
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There are simple filters based on date range and species group to help you look up photos. For more advanced filtering
options, your photos are presented in tabular form on the other explore pages.

8.3 Explore > Species Maps

The Explore > Species Maps page provides a really quick and easy way to draw maps of the various species data held
in iRecord.
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Simply search for the species you want to map in the table on the left and use the + button to add a map layer for that
species. You can:

• Add up to 4 species layers to the map at once

• Filter to show only your own records

• Use the filter row in the top of the species table to search for a species by name.
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CHAPTER

NINE

TUTORIAL - EXPLORING RECORDS

Now we’ve got to grips with the contents of the Explore menu, let’s take a guided tour which will take in some
more details. Before following this tutorial through, please visit your My Account page, then go to the Edit tab and
Preferences sub-tab. Change your Location to Dorset. You can change it back again afterwards but this way you will
be able to follow through the steps with roughly the same records. Whilst you are doing this, uncheck the Training
checkbox if it is currently checked so that we can see real records.

Now, go to Explore > All Records. Untick the My species groups only? checkbox above the map and click the
Filter button. Your map should look like this:

It’s kind of all very pretty, but not much use at the moment as it’s just a jumble of different species dots. So, what can
we do with this?

9.1 Filter the records table

The table of records below includes quite useful filtering facilities including wildcard searches. Lets draw a map of
records of the Silver Y moth (Autographa gamma). To do this you could type the latin name in the box a the top of
the Species column, or use a wildcard to search for the common name. So, type “silver y” into this box and press the
return key:
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You can see that not only has the grid filtered, but so has the map.

9.2 Drilling between the map and records table

Try clicking on one of the rows in the grid and watch what happens on the map. You should see that the record is
highlighted for you.

Next, double click on the same row in the grid. The map will zoom in to show you the records. Use the layer switcher
button in the top right of the map to switch to satellite view:

There are other dots on this map which I’d like to know more about. So, select the map query tool - that’s the blue
highlighted button with a question mark in it in the following image:
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Now, click on one of the dots on the map you are interested in. Not only does the dot highlight, but the grid is refiltered
to show just the records under the dot.

Tip: You can also drag a rectangle to select multiple grid squares to filter on.

So, you can quite easily find any record you see on the map in the grid, or find any record you see in the grid on the
map.

9.3 Exploring by species

Reload the page to start afresh again and make sure that the My species groups? filter is turned off as before. This
time, click on the Species tab in the data panel to view the list of species. Here are a few things you can experiment
with:

1. Click on the Number of Records column title to sort by record count, then click again to put the highest count
at the top.

2. Click once in the first row of the grid. This highlights all records of that species on the map. Try clicking in the
different rows to see the map update:

3. Click on the Species Summary button for the same row in the list of species. This is the button to the right of
the row with a magnifying glass icon. This will take you to a details page for that species.

9.3. Exploring by species 45



iRecord Training Manual, Release 1.0

4. Click on the Explore Records of Silver Y button (assuming that is the species you are viewing details for).
This takes you back to the Explore page with all records of that species loaded.

9.4 Record tools

For each record shown on the Explore page data tables, there are potentially up to 2 “tools” available in the rightmost
column in the grid:

• All records have a magnifying glass icon which zooms in to show you the details of a record.

• Records which you have entered yourself have an edit icon which returns you to the original data entry form for
the record. Note that if you edit a record that has been verified, or is part of a form submission that contains
records which have been verified, then these records will need to be reverified to check they remain accurate.
So don’t edit records that have been verified unless there is a good reason to do so.

Tip: The record details page lets you add a comment to the record which will be sent back to the recorder. For
example you might like to let them know if you agree or disagree with an identification.

To round this tutorial off, see if you can find the record of the queen Bombus terrestris you entered earlier and edit it
to change the grid reference. A hint - because this record was entered in training mode, you will have to set training
mode on your My Account page.
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CHAPTER

TEN

TUTORIAL - MY SITES

The My Sites facility in iRecord is a great way to keep a personal list of sites you regularly record at. You can also
add sites selected from a standard list of sites to your own personal list, currently the sites available are the National
Nature Reserves but other site types may be added in future.

Follow through the steps below to add one of your local recording patches to your account.

1. Select Explore > My Sites from the menu. Click the Create Site button near the bottom of the page to start
adding a new site on the Site Details page.

2. Enter a name for your site into the Site Name box.

3. Use the Search for Place on Map box to search for a nearby town or village. Once you have zoomed the map
to the vicinity of your site, use the methods of panning and zooming your map until the map includes all of your
site boundary.

4. Select the leftmost tool in the row of toolbuttons at the top of the map. This tool lets you specify the centre grid
reference of your site. Click once on your site’s approximate centre to set this.

5. Specify a comment for your site to describe it.

6. Using the map layer panel, switch to Google Satellite as your base layer.

7. Since our site is a polygon (it could be a linear site), choose the next tool to the right which is the draw polygon
tool.

8. Now, click once on the map on a corner of your site. Work your way around the site boundary, clicking once for
each change in direction of the site boundary to gradually build up the shape of your site. Double click to finish
once you have completed the boundary.

My site details form now looks like the following:
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Press the Submit button to complete the site creation process. Now, let’s try adding a casual record for our patch.
Make sure that your account is in training mode before going any further!

1. Select Record > Enter a casual record on the menu.

2. Set a record for today’s date and choose any species you would like to record.

3. In the Location box, type the first few characters of the name of the site you just created. iRecord will search
against your list of sites and find the matches. When the site name appears, select it. iRecord will zoom the map
straight in to show the site boundary for you.

4. Click once on the map to set the grid reference, zooming in further first if necessary.

5. Set the Habitat as appropriate for your record. Note that this value will be remembered for you the next time
you record at this site.

6. Save the record.

7. Go back to the Explore > My Sites page. This time, click the Explore button beside your site. This takes you to
the explore page, filtered to show your records from that site. Because I’m cheating and have already recorded
lots of records at my patch, here’s a screenshot of the site I created:
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Tip: You can use the date filters at the top of this page to filter the records by date. I’ve set myself a target of 365
species records in my garden for 2013, so I can use this to check on my progress easily. I’m woefully behind!
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CHAPTER

ELEVEN

USING THE FORMS LIBRARY

Throughout the tutorials so far, we’ve been concentrating on using the general purpose recording forms. These are
quite basic in terms of the attributes that you can record with each record, for example you can’t provide detailed life
stage information in the Stage field since the field’s values are general purpose. As well as more specialist recording
forms, iRecord also allows groups, schemes and societies to add forms for their own purposes, with attributes and
options appropriate to them. These are available on the Record > My Forms menu item. Some examples include:

11.1 Enter ladybird records

This form was designed by the UK Ladybird Survey and includes colour form and life stage attributes:

11.2 National Trust Dorset site recording forms

Forms were designed by surveyors of 2 National Trust sites in Dorset, Burton Bradstock and Golden Cap Estate:
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11.3 Intertidal Recording Form

This form was designed to capture intertidal records specifically:
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Because of the way that iRecord was developed, adding new custom forms such as these is a fairly simple process, so
the library of available forms is likely to continue growing.

Let’s take a look at how the forms library works. Visit the menu item Recording > My Forms. The forms library
allows you to pick and choose which forms you would like to “favourite”, meaning which forms you would like easy
access to. You can access any of the other forms at any time, they just aren’t made quite as convenient to access. When
you first visit this page, you won’t have any forms favourited, so it will show you all the available forms:
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This is the Find other forms mode, indicated by the button on the top right being pressed in. In this mode you can
click on the title of any form to use the form, or you can click the Add to favourites button associated with one of
the forms to add it to your list of favourites. Let’s add the ladybird recording form to our list of favourites by clicking
it’s button. The form is highlighted and the button changes to a Remove from favourites button showing that it is on
your list.

Now, reload the page. Because you have at least one form in your list of favourites, the page will now with the Find
other forms button not pressed in, so you are able to list just the forms you’ve favourited. Even more importantly, if
you hover over the Record > My Forms menu item you will see that the form(s) you have favourited are now listed
as sub-items ready for you to access at any time.
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When using the Find other forms mode, you might think that it looks like a chaotic disordered jumble of forms. In
fact, they are sorted so the ones which overlap your species group interests and recording locality are listed first and
ones which are less relevant to you are listed lower down. There is also a search facility to help you find forms.
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CHAPTER

TWELVE

SUMMARY REPORTS

The Summarise Menu option provides access to some quick and simple ways to view data summaries from iRecord.

12.1 General Summaries

Click on the Summarise > General Summaries menu item to access a collection of reports summarising the records
you have entered as well as the records entered into iRecord as a whole.

Hopefully the report titles are fairly self-explanatory. Here are a couple of examples

The My records density map page provides you with a vice county level heat map of where you have input your
records:
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The Species by group pie chart shows the relative number of species recorded in each species group:

Tip: Have a play with the different charts available and try clicking on the pie segments, chart bars and map regions
to quickly access a filtered version of the Explore page showing the underlying records and species.
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12.2 Survey Summaries

Specific surveys which host their records on iRecord sometimes opt to provide a summary page to show progress.
This might apply to a bioblitz or a survey of a specific site, for example. These summary pages are listed under the
Summarise > Survey summaries menu item. Here’s a screenshot of the summary page available for the 2012 Garden
Bioblitz trial:
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CHAPTER

THIRTEEN

VERIFICATION

Although not specifically part of this training material, verification is a very important part of the iRecord system. If
you are interested in knowing more, you can watch a video explaining the role of an expert verifier.
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http://www.youtube.com/watch?v=tSVy-zbbOZA
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